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Thank you very much for purchasing the LCMSsolution software for Shimadzu liquid chromatography / mass spectrometry
workstations (hereafter called “LCMSsolution”).

LCMSsolution allows you to control the liquid chromatograph (hereafter called “LC”) and the Mass Spectrometer (hereafter
called “MS”) from your personal computer, acquire chromatograms and other different kinds of data, and reanalyze the
acquired data under different parameters on your personal computer.

This manual is the tutrial in the most simplified analysis procedure using LCMSsolution which helps you to catch more knowl-
edge in other volumes or further actual operations.

The “Operation manual” and “Administration manual” are attached as separate volumes.

The Operation manual has been put together in order to familiarize you with the basic knowledge required to operate
LCMSsolution.  Be sure to read it thouroughly before using this software. After reading the manual, keep it in a safe place so
that it can be accessed whenever necessary.

The Administration manual covers the information useful for system administration such as the support features for GLP/GMP
or FDA 21CFR Part11, a set of regulations for electronic records and electronic signature. For more information on the func-
tions of LCMSsolution, refer to this on-line manual.

This manual assumes that the reader is knowledgeable of basic operations of Windows2000. For the operation of Win-
dows2000, refer to the instruction manual that comes with that product.

This manual sometimes explains commonly for LabSolutions series. And some explanations may use the drawings come from
sister products like LCsolution, if it does not cause misunderstanding in the range of explanations.

Introduction



The LCMSsolution package contains the following information that describes the operational procedures and functions.

This manual uses the following legends:

Using the instruction manual

Kinds of instruction manuals

Name Media Description

Operation guide for
LCMSsolution

Printed Document Provides tutrial on mostly basic analysis procedure using LCMSsolution.

Operation manual for
LCMSsolution

Printed Document Explains the operational procedures for data acquisition and analysis using
LCMSsolution.

Administration manual for
LCMSsolution

Printed Document Explains the operational procedures and basic idea of system administra-
tion and data management using LCMSsolution.

On-line help LCMSsolution program Provides detailed information on parameters and setting ranges. This is
accessible from the Help menu in LCMSsolution. (For using the on-line
help, refer to section “14.1.1 Using Help” in the Operation manual.)

Operation guide for
LCMSsolution
 (PDF version)

CD-ROM disk for installa-
tion

Provides the operation guide volume of the instruction manual as a PDF
file so that it can be viewed on your personal computer. The general table
of contents is available, including other instruction manuals (PDF ver-
sions). It allows you to use each instruction manual via the hyperlink. 

Operation manual for
LCMSsolution
 (PDF version)

CD-ROM disk for installa-
tion

Provides the operation volume of the instruction manual as a PDF file so
that it can be viewed on your personal computer. It is accessible from the
Help menu in LCMSsolution. (For using this PDF, refer to section “14.1.2
Using the Online Manual” in the Operation manual.)

Administration manual for
LCMSsolution
 (PDF version)

CD-ROM disk for installa-
tion

Provides the administration volume of the instruction manual as a PDF file
so that it can be referred to on-line whenever operations related to system
administration are needed. The general table of contents is available,
including all the instruction manuals (PDF versions). It allows you to use
each instruction manual via the hyperlink. 

Legends for instruction manual

Legend Meaning

Shows additional informations around the topic.

Points the reference informations.

Gives you tips.

<    > Shows a window or view name; e.g., <Data Acquisition> window or <Method> view.

[    ] Shows a parameter, tab, column, cell, bar name, menu command , that can be selected from the menu bar.

[ ]-[ ] command Shows a sequence of selecting the menu in the first [ ] and then selecting the command in the second [ ].
For example, [File]-[Print] command means that you should click on the File menu and then select the
Print command from the displayed list of commands.
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1.1 Basics of LCMSsolution

1   Making Preparations for Analysis

1.1 Basics of LCMSsolution

<LCMSsolution Launcher> - [Operation] menu icon

No. Icon Name Description

1 Analysis
Starts the application for configuring and controlling the system and
making a single-run or batch analysis.
(Starts <LCMS Analysis> in the Online mode)

2 Offline Editor
Starts the application for editing any method file or batch file not in
use during the analysis.
(Starts <LCMS Analysis> in the Offline mode)

3 Postrun
Starts the application for loading the acquired analysis data to create
a calibration curve or perform data processing.

4 Browser
Starts the application for browsing multiple analysis data together or
analyzing data together.

1

2

43
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Files used in LCMSsolution

[Admin Manual]: “4.1 Important File Concepts for Operation”

 Data structure in LCMSsolution

The data in the LCMSsolution is retained in data files, consisting various types of records and parameters such as the system
configuration, fine-tuning result, system conditions, and analysis conditions that have been used to acquire and analyze data.
This structure enables you to browse each data file for monitoring conditions and analysis parameters, thereby ensuring the
traceability of data.  This means that if a single data file is available, an analysis can be made again.

The method contained in the data file is a copy of the method file that was used to acquire and analyze data.  Therefore,
when any method parameter in the data file opened via <Data Analysis> is modified, the method contained in the data file is
modified rather than the method file.

[Admin Manual]: “4.1 Important File Concepts for Operation”

Extension Name Description
.lcm Method File Analysis condition, Data processing conditions, QA/

QC settings, calibration curve information, and sys-
tem configuration

.lcr Report Format File Report formats

.lcb Batch File Batch tables and batch settings

.lcd Data File Chromatograms, mass spectrums, peak tables, iden-
tification/quantitation results, report format, tuning
results, methods, and batch table



1.2 Starting the LCMSsolution
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1.2 Starting the LCMSsolution

This document assumes the following system configuration as an example to describe the procedure for an analysis:
High-pressure Gradient LCMS plus PDA (= Photo Diode Array) Detectors System

1 Check that the LC and MS units are On.

2 Check that nitrogen gas is sent to the MS unit.

3 Turn On the personal computer and
peripheral devices to start Windows.

4 Enter your user ID to log on.

5 Double-click the [LCMSsolution] icon  displayed on the Windows desktop.
<LCMSsolution Launcher> will be started.

Pump LC-10ADvp = 2 units

Auto sampler SIL-10ADvp

Column oven CTO-10A(C)vp

PDA detector SPD-M10Avp

Mass spectrometer LCMS-2010A

LC-10ADvp 

LCMS 2010A 
CTO-10Avp SPD M10Avp 

LC-10ADvp 

DGU-12A 

SCL-10Avp 

Power S/W
for pump

Power S/W for degasser Power S/W for column oven Power S/W for auto sampler

Power S/W
for MS unit

Power S/W for system controller

Power S/W for PDA detector

Power S/W



1.2 Starting the LCMSsolution

LabSolutions/LCMSsolution Guide4

6 Select [Operation] menu.

7 Click the [Analysis] icon .
The <Login> screen will appear.

8 Select “Admin” and click the [OK] button.
The LCMS analysis program will be started with
the <LCMS Analysis> main window displayed.

[Admin Manual]: “2.4 Registering (Changing/Delet-
ing) Users”, “2.5.2 Changing Passwords”

9 Click the [Data Acquisition] icon .

10Check that “Ready” is displayed.

If “Not Connected” is displayed, properly com-
plete <System Configuration>.

[Operation Manual]: “14.5 Configuring System”

76

8

9

10
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Description of <Data Acquisition> window

• Toolbar
Among the functions available on the Menu bar, the fre-
quently used ones and the functions to directly control the
analyzer are assigned to this bar.

• Assistant Bar
The icons to operate the application in accordance with
the general analysis flow are assigned to this bar.

• Instrument Parameters
A pane is displayed showing the parameters for the sys-
tem set up on <System Configuration>.
Set those parameters for data acquisition.

Instrument ParametersAssistant Bar

Toolbar
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2.1 Creating a new method file

2   Qualitative Processing (Single-run 

Analysis)
Set the parameters for the LC and MS units on the <Data Acquisition> window and then make an analysis.  This document
assumes an example of analysis under the following analytical conditions to specifically describe the procedure for the anal-
ysis.

2.1 Creating a new method file

1 Click the [New] button .
A new method file will be opened.

Column
Shim-pack VP-ODS 150mm x 2.0mm  i.d. 5µm
(Equivalent to Shimadzu P/N 228-34937-94)

Mobile phase
Binary Gradient mode
Pump A = Water, Pump B = Acetonitrile

Sample Papaverine 0.5, 1, 5, 25, 50 ng/µL (Shimadzu P/N 225-06613-05)

1



2.2 Setting the LC parameters
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2.2 Setting the LC parameters

2.2.1 Detecting the auto sampler rack

1 Click [Advanced] button.

2 Select the [Autosampler] tab.

3 Click [Detect Rack] button.

2.2.2 Setting the LC parameters

[Operation Manual]: “4.2.1 Setting the LC Parameters”

1 Click [Normal] button

2 Select the [Simple Settings] tab.

3 Enter “6” min in [LC Stop Time].

If you click [Apply to all acquisition time] button
after entering [LC Stop Time], [End Time] of all the
detectors become the same.

4 Enter values for the pump parameters.

5 Enter “6” min in [End Time] of PDA.

6 Enter “40” °C for the oven temperature.

Be sure to enter a value in [Stop/End Time] (measurement end time) in steps 3 and 5.

1 23

1

6

5

4

32

Mode Binary gradient

T.Flow  0.2mL/min

B.Conc  45%
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Entering the gradient mode conditions

This document describes the procedure for setting up the
pumps by assuming that liquid is sent in the gradient
mode at a constant mixture ratio of the mobile phase.
To change the gradient mode conditions, perform the fol-
lowing steps:

1 Select the [LC Time Prog.] tab.

2 Enter values in [Time], [Module], [Action],
and [Value] for the time program as
shown on the right side.

3 Click [Draw curve] button.
The entered time program will be displayed as a
graph.

Setting the pressure limit of a pump

If the column or the like is in an improper state, an error
may occur because of exceeding pump’s upper pressure
limit.  In this case, change the upper pressure limit by per-
forming the following steps:

1 Click [Advanced] button.

2 Select [Pump] tab.

3 Enter “15” MPa in [P.Max].

The default value for [P.Max] is 10 MPa.

1 2

3

1

3

2
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2.3 Setting the MS parameters

To set the MS (mass spectrometer) parameters, perform the following steps:

[Operation Manual]: “4.2.2 Setting the MS Parameters”

1 Select the [MS] tab.

2 Enter “6” min in [Acquisition Time].

3 Select an event.

4 Set the parameters for the selected
event.

5 Click [DownLoad] button.
The instrument parameters will be transferred to
the unit.  
The dialog box will be opened allowing you to
save the settings (method).

6 Enter “Method1.lcm” for the file name and
click [Save].
The method file will be saved and the set parame-
ters will be transferred to the unit.

1 243 5

Detector voltage 1.2kV

Measurement start m/z 200

Measurement end m/z 400

6
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Segment and Event

The LCMS-2010A provides the capability to allow you to change the analysis conditions in each specified time range during
an analysis. The analysis conditions (a set of analysis conditions) in the specified time range are called a “Segment”. Multi-
ple MS conditions may be specified for each segment and each of those conditions is called an “Event”.
Additions of segments and events allow you to specify more complicated MS analysis conditions. This document assumes
that an analysis is made under a single MS condition.

If multiple events are specified within the same segment, an analysis will be made under the condition specified for the event
time and then the next event will occur. When the final event specified in the segment is finished, the first event will be
resumed again.  Thus, the cycle (Event#1 → Event#2 → Event#3 → Event#1... for Segment#1 in the above example) will be
repeated for the time specified for the segment.

After the time specified for the segment has elapsed, similar operations will be performed for the next specified segment.

If the “Polarity” (“Positive” or “Negative”) is changed, 400 msec is required for this change. This means that the time of

the event after the polarity has been changed becomes shorter practically by 400 msec. Therefore, increase or

decrease the event time as necessary.

To add/delete any segment/event, right-click the
appropriate segment/event in the event tree and
select the desired option from the pop-up menu dis-
played.

Event 1 : +, Scan, m/z 50-200

Event 2 : -, SIM, m/z 100, 400

Event 3 : -, Scan, m/z 500 - 1400

Event 1 : +, SIM, ...

Event 2 : -, SIM, ...

0 10 20 30 [min]

Segment#1 Segment#2
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2.4 Starting the operation of the instrument

Before starting an analysis, click the “Instrument Control bar” button at the top of the screen to start the operation of the ana-
lyzer. It will take about 20 minutes until the operation becomes stable enough.

2.4.1 Starting the control of the MS unit

1 Click the following five buttons: [Open/
Close Nebulizing Gas], [CDL On/Off],
[Heat Block On/Off], [IG On/Off] (= Ion
Gauge On\Off), and [MS Detector On/
Off].
The MS unit will start operating.

When an analysis is made using the APCI for the
interface, the [APCI On/Off] button  is added.

2 For the LCMS-2010A, turn clockwise the
knob for the drying gas controller to set
the pressure.
For the LCMS-2010A-ESI: 0.1 MPa
For the LCMS-2010A-APCI: 0.02 MPa

Heat Block MS DetectorNebulizing Gas

Ion GaugeCDL Heater

Turn the knob clockwise.
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2.4.2 Starting the operation of the LC unit

1 Click [Instrument On/Off] button.
The LC unit will start operating under the condi-
tions specified in the method file.

HPLC Instrument
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2.4.3 Selecting a graph to be displayed in the <Chromatogram> view

The <Chromatogram> view allows you to specify the types and ranges of axes for the graph to be displayed.

[Operation Manual]: “11.2 Customizing Windows”

1 Right-click anywhere on the graph and
select the [Display Settings] menu.

2 Select the [MS] tab.
Enter values for m/z and other parameters for the
mass chromatogram to be displayed.

3 Tick the check boxes on the 1st and 2nd
rows.

4 Enter 340.15 on the 2nd row of the m/z
column.
In this example, the mass chromatogram will be
displayed according to TIC and m/z = 340.15.

5 Click [OK] button.

To leave the <Display Settings> window open, click
[Apply] button.

1

2

5

43



2.5 Acquiring data through a single-run analysis
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2.5 Acquiring data through a single-run analysis

To make a single-run analysis under the conditions specified in “2.2 Setting the LC parameters” and “2.3 Setting the MS
parameters”, perform the following steps:

1 Click the [Single Start] icon .
The <Single Run> window will be displayed.

[Operation Manual]: “4.3 Starting a Single-run Anal-
ysis”

2 Enter “Sample1.lcd” for the data file name
to be created.

3 Enter vial number “3” and injection
amount “1”.
In this example, previously fill 5 ng/µL of papav-
erine into vial No. 3 of the auto sampler, and inject
1 µL from that vial.

4 Click [OK] buttom.
The single-run analysis will be started.
After the [Acquisition Time] specified in the
method file has elapsed, the analysis is finished
automatically.

1

2

43



2.6 Performing qualitative processing on <MS Data Analysis>
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2.6 Performing qualitative processing on <MS Data
Analysis>

2.6.1 Starting the <MS Data Analysis>

After the single-run analysis has been finished, perform data analysis as follows:

1 Click the [Data Analysis] icon .
<MS Data Analysis> will be started.
The last acquired data will be loaded and then dis-
played.

[Operation Manual]: “5.1 Operation in the <MS Data
Analysis> Window”

When the data file is first opened, only TIC is dis-
played in the <Chromatogram> View.

Dragging the cursor on each graph will allow you to
enlarge that area.
Right-clicking anywhere on each graph will allow
you to select the [Initialize Zoom] or [Undo Zoom]
option.

Clicking the [+] or [-] button will allow you to
increase or decrease the level of the intensity axis.

Dragging the cursor on the splitter (frame) will allow
you to change the aspect ratio of each view.

1

Mass Spectrum

MS Chromatogram

[+] and [-] buttonsSplitter (Frame)



2.6 Performing qualitative processing on <MS Data Analysis>
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2.6.2 Displaying a mass spectrum

1 Double-click anywhere on the chromato-
gram.
The cut-out cursor will be moved to that time. 
The mass spectrum for the cut-out cursor position
in the <Chromatogram> View will be displayed in
the <Spectrum> View.

Averaging the mass spectrum

Averaging the mass spectrum will allow you to obtain a clearer spectrum.

1 Click the [Average Spectrum] button
on the Toolbar.

2 Drag the cursor on the chromatogram to
define the area you want to average.
The averaged spectrum in the defined time range
(between 4.517 and 4.983 min in this example)
will be displayed.

1

1

2



2.6 Performing qualitative processing on <MS Data Analysis>
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Performing subtractive processing of a mass spectrum

If the background mass spectrum is subtracted from the averaged spectrum, an even clearer spectrum can be obtained.

1 With the averaged spectrum displayed,
click the [Average & Subtract Spectrum]
button  on the Toolbar.

2 Drag the cursor on the chromatogram to
define the area you want to subtract.
The spectrum obtained by subtracting the back-
ground will be displayed.
The information displayed above the spectrum
graph indicates that the averaged spectrum for
retention time between 3.400 and 4.227 min has
been subtracted from that for retention time
between 4.517 and 4.983 min.

Registering the averaged/subtracted spectrum in the “Spectrum Process Table”

If you register the averaged/subtracted spectrum in the spectrum processing table, you will be able to reproduce that spec-
trum easily on a later day.

1 Right-click anywhere on the spectrum
graph and select [Register to Spectrum
Process Table].
The averaged/subtracted mass spectrum will be
registered.

Alternatively, it can also be registered by clicking the
 button on the Toolbar.

1

2



2.6 Performing qualitative processing on <MS Data Analysis>
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2.6.3 Displaying a mass chromatogram

1 Double-click a mass spectrum peak.
A mass chromatogram will be additionally dis-
played in the <Chromatogram> View.
The settings for the mass chromatogram are regis-
tered in the <Fragment Table> window.

Opening the <Fragment Table> window

1 Click the [Fragment Table] icon .

The <Fragment Table> window will be displayed.

Deleting the erroneously registered chromatogram

1 Remove a tick mark from the check box
in the [Disp.] column on <Fragment
Table> window.

2 Click [OK] button.
The window will be closed and the chromatogram
will be hidden.

1

2

1



2.7 Performing peak integration (peak detection)
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2.7 Performing peak integration (peak detection)

In this example, change the integration conditions in a single-run analysis and then perform peak integration again as fol-
lows:

1 Click the [Qualitative Peak Integration]
icon .
The <Qualitative Peak Integration> window will
be displayed.

2 Select the [Integration] tab.

3 Select “Detail” for the integration method.
If you select Auto (Area) or Auto (Height), peaks
in the number close to the entered maximum num-
ber of peaks will be detected.

4 Enter “10” sec in Width.
If you specify the minimum width of peaks to be
detected, the noise peak will be eliminated.
Peaks will be detected to the extent that the half-
width value is one forth the Width value.

5 Enter “1000” /min for the Slope value.
This is the parameter that determines the start and
end points of the peak.
When the absolute value of the gradient of the
chromatogram becomes this value, the start and
end points of the peak are determined there.

6 Click [OK] button.
The postrun will be carried out using the qualita-
tive integration parameters you have set.

7 Click the [Qualitative Table] icon .
The <Qualitative Table> window will be dis-
played.

8 Select the [TIC] tab.
The integration result will be displayed.

The [Spectrum Process] tab allows you to check the
registered averaged spectrum.

1
7

2

6

3
4
5

8
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Simple procedure for setting the integration parameters

Temporarily enter a little smaller values for Width and Slope and then double them, and see how peaks are detected*.  In the
example given in this document, first enter Width 10 and Slope 1000 and then Width 20 and Slope 2000.
*  If the Width value is excessively increased, no minute noises will be detected as peaks.

If the Slope value is excessively increased, no moderate changes in the baseline will be detected as peaks.

Repeat the above steps and when the unnecessary peaks become undetectable, adopt the integration parameter at that point.

Checking data with <Data Explorer>

The LCMSsolution manages the data files, method files, batch files, and other related files in “Project Folders”.
<Data Explorer> allows you to manage the project of the LCMSsolution more effectively.

Project folders may be freely created, copied, or handled with <Data Explorer> of the LCMSsolution and the standard
Explorer of Windows.

[Operation Manual]: “13.2 Managing Files Effectively”
[Admin Manual]: “6.1.1 Customizing Data Explorer Display Data”

1 Click the [Data Explorer] button .
This will toggle between displaying and hiding
<Data Explorer>.

2 Change the display for each file type.

Double-clicking the file or dragging and dropping it
to the window will allow you to load the file.

3 Right-click anywhere on the file icon.
A popup menu will appear.

Data Preview
The highlighted data file can be previewed.
Part of the sample information can also be checked.

Show File Info.
When “Detail” for [File View] is selected, the sample
name and other additional information will also be
displayed as the file information.

2

Preview

3
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2.8 Printing out the analysis result

To print out the result of qualitative processing, perform the following steps.

2.8.1 Printing out a “Graph Image”

Print out the chromatogram and MS spectrum displayed on the screen as follows:

1 Click the [Print] button .
[Print Image] will be carried out.



2.8 Printing out the analysis result
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Example of printing out a graph image
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2.8.2 Selecting a layout for printing

<Data Report> allows you to print out a report image in the report format edited in the layout edit pane.
In this example, load the preinstalled report format file “Sample1.lcr” to print out a graph image.

[Operation Manual]: “10.2 Reprinting Data Processing Results”

1 Click the [Data Report] icon .
The data report will be displayed.

2 Select the [Report Format] tab with <Data
Explorer>.

3 Drag and drop the file icon to the layout
edit pane located on the right side.
The “Sample1.lcr” report format will be dis-
played.

4 Click the [Print] icon .
The report in the layout edit pane will be printed
out.

1

3

4 2
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Example of using the report format file for printing
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3.1 Creating a “Compound Table”

3   Quantitative Processing (Batch Anal-

ysis)

3.1 Creating a “Compound Table”

In the quantitative processing, the concentration of the compound contained in an “Unknown Sample” is calculated by creat-
ing a “Calibration Curve” with a “Standard Sample” of a known concentration, which contains the same compound as that
being quantitatively analyzed.
In this example, inject 1 µL of a standard sample containing 0.5, 1, and 5 ng/µL of papaverine to create a calibration curve.
Simulate the quantitative processing to analyze 0.75 ng/µL of papaverine as an unknown sample.

[Operation Manual]: “5.5.2 Editing a “Compound Table””, “5.5.4 Using <Compound Table Wizard>”

3.1.1 Setting the quantitative parameters in <MS Data Analysis>

Set the quantitative parameters in the following steps using the papaverine data (Sample1.lcd) that has been loaded to <MS
Data Analysis> in the previous chapter.

1 Click the [Quantitative Parameters]
icon .

2 Select the [Integration] tab.

3 Enter “100” /min for Slope.
In principle, enter a value equivalent to 1/2000 the
targeted peak height.
If no peak is detected, reduce the Slope value by
half.

1
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4 Select the [Quantitative] tab.

5 Select “External Standard” for [Quantita-
tive Method].

6 Enter “3” for [# of Calib. Levels].

7 Click [OK] button.

3.1.2 Creating a “Compound Table”

To complete the quantitative settings for each compound, set “Compound Table” to [Edit Mode].

1 Click [Edit] button  in the <Compound Table> View.

2 Enter values in the “Compound Table”.

If you click a peak in the <Chromatogram> View
with the [Ret. Time] cell highlighted, the retention
time for that chromatogram peak will be entered
automatically.

If you click a peak in the <Spectrum> view with the
[m/z] cell highlighted, the m/z value for that spec-
trum peak will be entered automatically.

3 Click [View] button .
The edited settings will be established.

7

4 5

6

Name Type m/z Ret. Time Conc. 1 Conc. 2 Conc. 3

Papaverine Target 340.15 4.800 0.5 1 5
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Checking and saving the quantitative parameters/compound table

1 Click the [Peak Integration] icon .

2 Check for the identification mark ( ) on
the chromatogram peak.
The identification mark is given to the identified
peak.
The peak has the (↑) and (↓) marks at the starting
and end points, respectively.
If the peak integration fails, adjust the Slope value
among the integration parameters.

3 Check that the peak has been identified
properly, and then click the [Apply to
Method] icon .

The Save dialog box will be opened.

4 Check that “Method1.lcm” is selected for
the file name, and then click [Save] but-
ton.
The method file will be overwritten.

2
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